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Processing:. After this course

* Use the processing environment and:
e -create programs ... that run

- ...that draw pictures

- ...that display animations

« - ...that display interactive animations
« - ... that animate interactive objects

last but not least: make all of these work together as
you like ... great freedom to create
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Processing: After this 1st lesson

« Start processing.
* Run your first program in processing

« Write programs that create various static objects
l.e. “pictures”

 Change these programs to change the pictures.

* Understand how the pictures change when you
change the program.

 Have afirst idea about creating interactive objects.
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After 1st |lesson:

What should you understand ?

 Why processing (and programming in general) is
Interesting and important for you as a designer

e what syntax is

* what expressions are

« what (basic) types and variables are

« what semantics is and how to look it up
* how to think about programs (a little)
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Downloading processing...

(o to http://processing.org
 Download Processing 2.2.1

« Create a directory to store the Processing program stuff

(e.g. C:\Users\<username>\Programs)
« Extract the zip file into that directory

* Create a shortcut to Processing on your desktop

* Create a directory to store your sketches
(e.g. C:\Users\<username>\Documents\Processing)
and configure Processing to use that sketches folder...
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http://processing.org/

Before you start ...

Experience some Examples

 Open menu:
 File|Examples|Topics|interaction|
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A little experiment ...

Look at the chart: saythe
Color not the word

Black Blue Green
White Green
Green o Yellow
Yellow Pink Tan
Red Yellow White

Example produces a Left\Right brain conflict
The right brain tries to say the color

The left brain tries to read the color
http://OfficeSpam.ChattaBlogs.com
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Left & Right brain

EXPERIENCE =
USABILITY/ANALYTIC +  DESIGN/CREATIVE

Left-Brain Functions
Analytic thought

Right-Brain Functions
Hodistic thought

Imwition
Language Creatnity
Scienca and Artand
math music

\ X
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Left versus Right

« abstract objects represented in (programming)
language are easy to change and to duplicate but are
not immediately graspable or visible

e concrete objects that are created in matter can be
Inspected and manipulated, but are more difficult
to change and to duplicate.
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We want best of both worlds

» define and create objects through language
« grasp and inspect objects through senses.

* Processing can execute abstract instructions in a
computer language and translate these into
something that you can experience through the
senses.
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Processing language : How does it work?

* processing is an imperative language: that means
you use the language to give commands

« The computer creates the application by executing
the commands one after the other ... itis a

seguential language

« compare with written music : parallel (orchestra)
e can also be done in programs ...but very difficult.
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Lets Start Programming...

* Click on the processing icon ...

 Window opens with: Run, Stop, New, Open,
Save,Export Application.

File Edit Sketch Tools Help

==
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First program “Hello you”

print("'hello you");

print(""hello™);

print(’'you');

printIn(’'‘commands are separated by
semicolons™);

e print(5*3);

* print("'We count'+ 2+1+5+10 + 'characters');
e print(""We count"+ (2+1+5+10) + "characters™);

P TU
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Correctness : 3 Levels

« Syntax (language form) : wellformed grammatical
expressions: orders of brackets, semicolons,
operators, letters and numbers.

* Types (kinds of things) : distinghuish apples from
oranges

« Semantics (meaning) : does the program do what
you want ?
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Correctness : 3 Levels

Berlage boult the Schrdder house

Berlage build the Schrdder house

Berlage built the Schroder house

Rietveld built the Schroder house
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Syntax : wellformed or not ? Try some

examples ...

 print(""hhhh ggg");

o print('a'); print(''b™);
o print(8); {print(8);}

* {{{print(8);}}}

* print(“hello you)™; < syntax error: perhaps a missing right parenthesis

« // this i1Is just a comment ....
o print("jjjhhh ) ™) = unexpected token: null

* print(’a’™) print('b™) =» syntax error: maybe a missing semicolon

¢ commands can contain expressions ....
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Expressions can be nested

* 3*4

- sin(3*4)

= sin(3* tan(b) 7/ exp(sin(cos(0.45454))))

« "abcd"+"efgh"
- "abcd" + (“ef" + "gh")
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String '‘hhhheeeee' + '"aaa" + "'nnbn99 bnb"

Int 8 9*97978787 1-9988989

float 2333 .5555
° sin( -3 * 5677.455)
. 3.4e+38

basic types are: String, float, int, boolean, char, byte
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variables

 Avariable is a named location where a certain type
of value can be stored

« declare; initialize, use, scope.

« String ankExample;

« anExample “fghjkl";

 anExample anExample + ankExample;
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Variable 2

int multiplier = 5;

multiplier = multiplier + 4;

float p1 = 3.1415926535897932;

print(multiplier * pi) ;
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SEMANTICS

The meaning of the command; this may depend on type.

int myAge;
myAge = 8;
print(myAge * 8 );
e print(’" 8 + 8 ');

- print(’'l count™+ 1+1+5+10 + "characters);
e print(myAge+ (1+1+5+10) );

(to be continued)
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How to think about commands:

setting up a picture, or later a stage, using predefined primitives

first start with a static picture:
create empty picture with command size:

si1ze(200,200);
Next: specify what you put where:
you can use various standard primitives with parameters:

point(20,45);

 line(C 0,0,100,150);
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go to menu:

Example|Basics|Form|
run: Pointslines

what is semantics (meaning)
° of . stroke(153) ?
o . background(0)?
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Semantics

To find the meaning look for the (informal)
specifications ..

Select and right click on “stroke” to find out
choose: find in reference

Same on “background” to find out ...

these commands gpecify drawing parameters
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Specify drawing parameters ...

* stroke(255); 255 = white, 0 = black in between are
shade of gray ..

» background(200,23,130); (you can use color)

* noStroke() ...etc various primitives

 Processing reference
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https://processing.org/reference/

Also two dimensional shapes are possible ...

* rect(20,20,60,120);
- ellipse( 50,50,30,99);

« Example|Basics|Form|

 run: ghapePrimitives
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Interactive drawings ...

e Create a stage with :
 void setup() {

- size(200, 200):
-}

e then you can draw ... continuously ...
 with the draw command ..

 For example ...
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Interactive drawings ...

void setup() {

void

size(200, 200);

smooth(); // makes forms smoother
strokeWeight(2); // how thick lines are
stroke(255); // color of lines (white)
draw() {

background(mouseX, mouseY, 80); // background color
11ne(200, 0, mouseX, mouseY);
I ine(mouseX, mouseY, 0, 200);
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Remark on style

proper indentation
comprehensible comments (LOTS!)
(using Auto Format in Tools menu, if you like it, A T)

balanced pictures ...
beautiful movements ...
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Where we will be in three weeks?

Computer Generated 2012 Computer Generated 2012
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Kasimir Malevich, Suprematist
Painting: Airlane Flying, 1915.
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Kasimir Malevich, Suprematist
Painting: eight red rectangles,
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Processing libraries

e Reference
e https://processing.org/reference/libraries/

Processing

/ Processing

Cover Libraries. Extend Processing beyond graphics and images into audio,
Dowmload video, and communication with other devices.
Exhibition

The following libraries are created by the Processing Foundation, The PDF Export, Network, Serial, and DXF
Export libraries are distributed with Procesing. The Video and Sound libraries need to be downloaded through

i{;:rerelnce the Library Manager. Select "Add Library...” from the "Import Library...” submenu within the Sketch menu.

aries

Tools PDF Export Serial Video

Environment Create PDF files. These vector graphics Send data between Processing and Read images from a camera, play
files can be scaled to any size and external hardware through serial movie files, and create movies.

Tutorials printed at high resolutions. communication (RS-232).

Examples Sound

Books Network DXF Export Playback audio files, audio input,

Handbook Send and receive data over the Create DXF files to save geometry for  synthesize sound, and effects.
Intemnet through simple clients and loading into other programs. It works

Overview servers. with triangle-based graphics Hardware 1/0

People induding polygons, boxes, and Access peripherals on the Raspberry

spheres. Pi and other Linux-based computers

Shop
Contributions

» Forum

» GitHub Contributed Libraries must be downloaded individually. Select "Add Library..” from the "Tmport Library..”

» Issues submenu within the Sketch menu. Not all available libraries have been converted to show up in "Add
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https://processing.org/reference/libraries/

Sketch = Import Library = Add library

B sketch_150903b | Processing 2.2.1 [E=EER )
File Edit Sketch Tools Help B Library Manager = B8] &
Category: Al -
sketch_150903b \ ' “ N | | Temboo by Temboo -

Generats code to connect to 100+ APIs, code
utilities, and databases in Processing.

TimedEvents by Jason Gessner
A couple of classes for firing off timed events at
regular or random intervals.

ttslib by Nikolaus Gradwahl
ttslib makes your sketches speak with the help
of freetts.

twitterdj

ble. | Remove |

imple UDP communication, as well as
upport. | Remove -

multica

Could not move contribution to backup folder.
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Standard PDF export library

o pdf

import processing.pdf.*; <€ Import library

size(600, 600);

beginRecord(PDF, "line.pdf");

background(255);

stroke(0, 20);
strokeWeight(20.0); Use library functionality

line(200, 0, 400, height);

endRecord();
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Information

All up-to-date information will be visible in the wiki:
e http://wiki.id.tue.nl/creapro/CreativeProgramming201511

All processing language info can be found on
e http://www.processing.orq/reference/

Inspiration
e http://www.openprocessing.orq/
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Books

Must-have

Getting Started with Processing, by By Casey Reas, Ben Fry, e-Book and hard copy
available from O'Reilly

Recommended-to-have

Learning Processing: A Beginner's Guide to Programming Images, Animation, and
Interaction, Daniel Shiffman.

Published August 2008, Morgan Kaufmann. 450 pages. Paperback, Available from
LUCID, or from Amazon

Programming Interactivity: A Designer's Guide to Processing, Arduino, and
openFrameworks (Paperback) by Joshua Noble (Author). Very good one, covers many
topics in Competency Il. Available from LUCID. Also see
http://programminginteractivity.com

Processing: Creative Coding and Computational Art (Foundation)

Ira Greenberg (Foreword by Keith Peters)., Published 28 May 2007, Friends of Ed. 840
pages. Hardcover. Available from LUCID

Making Things Talk: Practical Methods for Connecting Physical Objects

Tom lgoe, Published 28 September 2007, O'Reilly. 428 pages. Paperback.

Available from LUCID
Technische Universiteit
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http://programminginteractivity.com/

Some getting-started excercises for you

Statistics:

« Make a program with variables containing the ages of you and some of
your friends

* Let the program calculate the average and the standard deviation and
print it orderly using print and printiln

http://www.mathsisfun.com/data/standard-deviation.html

Geometry:

* Make a program with at least five 1nt or Float variables to be used as
parameters

* Let the program create an abstract geometric composition using these
parameters

« Play with the parameters to optimize aesthetic balance
Technische Universiteit
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End of slide show




Design Process: Integrate various skills
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Hummels & Frens: Reflective
Transformational Design model
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